The Equilib module
•
•

Use Equilib for treating complex heterogeneous equilibrium.
Equilib accesses the compound and solution databases.
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The Equilib module

Click on Equilib in the
main FactSage window.
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From stoichiometric reactions to complex equilibria

In the following three slides is shown the transition from the
simple stoichiometric reaction approach to the complex
equilibrium calculation.
The user only needs to define the input substances in order to
set the elementary components of the system and their amounts.
After that the Gibbs energy is minimized for fixed values of T and
P varying the amounts of the possible products under the
constraint that the element balances must be kept constant.
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Using Reaction and Equilib programs to identify the most probable reaction
What are the products of the following reaction at 25°C:
Mg + 3 Cu2O + 2 Fe3C + Ar ?
If we assume that only pure stoichiometric compounds can be formed, and if we
ignore kinetic considerations, then using the Reaction program, we see (on the
following page) there are several possibilities. For example:
1

MgO + 6 Cu + 4.5 Fe + 2 C + 0.5 Fe3O4 + Ar

2

MgO + 6 Cu + 4.667 Fe + 2 C + 0.667 Fe2O3 + Ar

3

MgCO3 + 6 Cu + 6 Fe + 1 C +Ar

4

6 Cu + 4.667 Fe + 2 C + 0.667 MgFe2O4 + 0.333 MgO + Ar
etc…

According to the Reaction program, reaction 1 has the most negative Gibbs
energy change. Hence, according to thermodynamic laws, this is the most
probable reaction.
By the method of Gibbs energy minimization, program Equilib identifies the
most probable reaction in one calculation. This is demonstrated in the following
pages.
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Reaction program: 4 possible isothermal isobaric reactions and 4 values of ∆G
Most
negative ∆G

Reaction 1

∆G1 ≈ -670 kJ

Reaction 2
∆G2 ≈ -659 kJ

Reaction 3
∆G3 ≈ -621 kJ

Reaction 4
∆G4 ≈ -668 kJ
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Gibbs Energy Minimization
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Equilib determines the
combination of ni, Pi and Xi which
minimizes the total Gibbs energy
G of the system.
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An introductory application: Mg + 3 Cu2O + 2 Fe3C + Ar

The following five slides show how the Equilib module is used in
order to obtain a result for a simple complex equilibrium
calculation.
Four stoichiometric pure substances are entered to define the
chemical composition of the system (1 mole of Mg, 3 Cu2O, 2
Fe3C, 1 Ar ). The values for T(emperature) and P(ressure) are
fixed, the possible product species (all gases, all solids) are
selected. Then the calculate button is pressed.
The equilibrium table is shown in both output formats, the FACT
format and the ChemSage format.
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Reactants window – entering a new reaction
Equilib has 4 windows:

Reactants
window

Add a New Reactant
Reaction Table

Reactants window
Menu window
List window
Results
window

Open

1st entry:
Click on
New
Reaction
initial conditions
checkbox is not
selected

2nd entry:
Define the reactants.
List of compound and
solution databases

Press «Next» to go to the Menu window
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Menu window –possible products, final T and P, and calculating the equilibrium

Menu window
Save

Summary of the Reactants window.

Open
New Reaction

3rd entry:
Selection of
compound products:
ideal gas phase and
pure solids.

4th entry:
Final conditions:
25°C, 1 atm.
5th. Press to calculate equilibrium.
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Results window – FACT format output.
The equilibrium products: Cu, Fe, C, MgO, Fe3O4 and Ar satisfy
the mass balance and minimize the Gibbs energy.

Results window

1 mol of product gas at
1 atm, treated as ideal :
mainly Ar.

These are mole fractions Xi , in
an ideal gas: Pi = Xi × Ptotal or
P(CO2)eq = 0.17814 x 10-19 atm.
6 mol Cu(s1)

Note the pure
stable
stoichiometric
solids:
activity = 1.0

4.5 mol Fe(s1)
2 mol C(s1) [graphite]
1 mol MgO(s1)
0.5 mol Fe3O4(s1)
Solids beyond this point are not formed: 0 mol
and activity < 1.0
They are ordered with regard to activity.
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Results window – ChemSage format output
Menu bar: Output > Format > ChemSage Format

Final conditions

Amount
of reactants
Product
gases: gas
fugacities
are calculated
Product:
stable pure
stoichiometric
solids
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Additional output using the List feature

In addition to the result tables which are displayed in various
selectable formats in the Results screen of Equilib there is a
multitude of additional output options which are accessible
through the List window.
The following four slides illustrate various options in the List
window.
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List window – manipulating the results
Final conditions
List window

Display of gas fugacities,
for example:
fCO2= 1.7814×10-20 atm.
In an ideal gas, the
fugacity is equal to the
partial pressure. Hence:
PCO = XCO × PT =
2
2

choice
of
phases:
solid
and

Sorry –
diamond is
not formed
adiamond< 1

fCO2= 1.7814 × 10-20 atm

GAS

format and
ordered with
respect to moles

Databases used
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List window – distribution format
For example, Fe is distributed in: a gas phase: 0% as Fe(g)

2 solid phases: 75% as Fe(s) and 25% as Fe3O4(s)

3. Scroll

1. Select
distribution
format

2. Press Refresh
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List window – thermodynamic data format
Selection:
1. Show: pure solid phases
2. Format: thermodynamic data

3. And press Refresh
4. To obtain the
thermodynamic data format

«Absolute» values of Gibbs energy G°.
∆G° for the reaction:
3 Fe(s) + C(s) = Fe3C(s)
is given by:
∆G° = G°Fe C - [ 3G°Fe + G°C ]
3
= -7594.9 - [ 3(-8133.5) + (-1711.4)]
= 18517 J/mol
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Comparison of Gibbs energy values obtained by the Reaction and the Equilib programs

Selecting the initial
conditions and
specifying the phase
of each reactant at
25ºC and 1 atm
pressure…

Thermodynamic
functions: ∆H, ∆G, ∆V,
∆S, ∆U, ∆A and Prod V.
The value of ∆G is the
same as the Reaction
program (Reaction 1,
page 3)

A spontaneous isobaric
isothermal chemical reaction
takes place (∆G<0) and the
reaction is exothermic:
∆H = - 693.3 kJ

…
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Getting HELP by way of the right mouse button

The following twelve slides show how the right mouse button is
used in the various screens of the Equilib module in order to
obtain context related HELP.
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Reactants window – Help > More information...
Menu bar: Help > More information...

« Point to a frame heading
or input box and then click
the mouse right button.
button »
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Reactants or Menu window - Help > Directory of examples...
Reactants or Menu window menu bar:
Help > Directory of examples...

If you want to Change
Directory then go to
File > Directory >
[Select a directory] or
press on

View
Delete

Short description
of the example
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Reactants or Menu window – for a PowerPoint presentation

Reactants or Menu window menu bar:
Help > Slide Show > More slides… > Directory of examples...
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The mouse right button - Reactants
Click with the mouse right button
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Help: – the mouse right button
with the mouse right button in the enclosed areas:
header or input box and information boxes will appear.

Click

1

2

3

5

4

6

7

9

Mass info
Mass units
Species info
Species access to
ViewData
5. Phase
6. Temperature info
7. Temperature units
8. Pressure info
9. Pressure units
10. Stream number info
11. Data info
12. Databases info
1.
2.
3.
4.

8

10 11

12
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Help – Example of mouse right button, Mass: 1. Header and 2. Input Box

1

Conversion of mass units
2

Selection of mass units
Default setting for masses
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Units window: T,P, Energy, Mass and Volume
Reactants Menu bar: Units >

Move the arrow through
the frames to see the
conversion factors.
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Homogeneous Gaseous Equilibria

Reacting H2S with Cl2
Products selection:
ideal gas solution phase

Product T= 1500 K
and P=2 atm

Press
«Calculate»
Calculate

Drop-down menu for extensive property
Equilib 6.8

www.factsage.com

H2S + Cl2 = Results window, FACT Format Output

Mole fraction XHCl = 0.65092

Total pressure Ptotal = 2.0 atm

⇒ PHCl = XHCl × Ptotal = 1.30184 atm
Equilib 6.9
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List window – Help >

“+” denotes species or phase is selected as a possible product.

Other options are available. Click right button for more …

…and go to
the next slide

Point to a frame heading
or input box, a message
box appears and then
click the mouse right
button
Equilib 6.10
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Help – Another example of the use of the mouse right button

1

2

3
Click mouse right button to custom select species for gas species

Click mouse right button for extended menu on H2S(g)

4
Equilib 6.11

…and go to the next slide
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Some Help features in Equilib
To get all the information you need about the extended menu
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Constant volume calculations

Equilib also permits the calculation of equilibrium states for a
given gas volume.
The following five slides show how this feature is used to
investigate the thermal decomposition of SiI4.
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Simple heterogeneous equilibrium: thermal decomposition of SiI4
Species selection for the
thermal decomposition of SiI4:
an ideal solution gas phase
and pure solids are selected
as possible products.
To view a list of the species
selected before computation
and specify a pure solid Si
phase instead of 3 pure solids,
click the mouse right button
at a «Compound species»
input box or press the
«List Window» button

Computations are at 1400 K
for two fixed volumes: 1000 and 10000 litres.
Equilib 7.1
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Custom selection of product species: a short-cut
1. Click with mouse right button.

2. Select a species:
Click on its + column or press {Ins}
or {Del} to add or remove it. For a
group of species, drag the mouse
first and then press {Ins} or {Del}.

4.

* A custom selection
for the solid phase

3. Press «OK»
Equilib 7.2
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The Selection Window

You can also double
click on the column
header to sort the list.
Add columns to the list filled with the data you have requested or calculated.

Note: Your last selection becomes a default setting.
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Results window – 1400 K, 1000 L for SiI4
First tab [page 1/2] (selected): 1400 K, 0.2281 atm

Fixed volume:
1000 L

Second tab: 1400 K, 3.529E-02 atm [page 2/2]
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Decomposition of SiI4 at lower vapor pressures
V = 1000 L
T = 1400 K, P = 0.22813 atm
0 mol (no Si(s) formed)
activity < 1

V = 10000 L
T = 1400 K, P = 0.03529 atm
0.25082 mol Si(s) formed
activity = 1
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Constant pressure calculations in steps

In the following four slides is demonstrated how the total
pressure of an equilibrium state can be set, and how this affects
the result.
The Pidgeon process to produce pure Mg via a gas phase
equilibrium involving MgO and Si is used as an example.
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Effect of Pressure on Simple Heterogeneous Equilibria:
Pidgeon Process
for the Production of
Magnesium:
Magnesium
Apparatus Schema

Radiation Baffles

Ni - Cr Alloy Retort

Water-cooled
vacuum connection
also condenses alkalis

Mg(Ca)O + Fe - Si
Heated to 1423 K
for Mg Reduction

Mg condensed on
removable sleeve

Equilibrium Mg partial
pressure developed at
the hot end of the retort

Final Conditions:
two different pressures
and

one temperature
result in
2 calculations
Equilib 8.1
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Reacting MgO with Si at 1 atm – no reaction
Reactants

0 mol of gas, however XMg= 1.0876×10-3 and Ptotal= 1 atm,
hence PMg eq= 1.0876×10-3 atm

Products
Σ P gas species = 1.0969×10-3 atm
No reaction takes
place because the
pressure (1 atm)
is too

high for the
gas phase

Note: Unit activity but 0 mol. i.e. it is «thermodynamically ready» to form.
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MgO and Si reaction at a reduced total pressure
The gas phase is stable under a reduced total pressure.
XMg= 0.99151 and Ptotal= 0.001 atm, hence PMg eq= 9.91×10-4 atm

Gas phase:
numbers are
mole fractions

Coexisting
phases

Compare the formation of the gas
phase here at 10-3 atm with the
previous page where pressure is 1 atm.

Refer to the next page for the
distribution of elements in the
products.
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Pidgeon Process for the Production of Magnesium: Results
T = 1423 K
Ptotal= 0.001 atm

Mg(g) condenses on watercooled removable sleeve

Radiation Baffles
Ni - Cr Alloy Retort

Mg(Ca)O + Fe - Si
Heated to 1423 K
for Mg Reduction

Water-cooled
vacuum connection
also condenses alkalis
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Using non-ideal gas data

For some gas species the FACT database contains additional
values which permit their treatment as non-ideal gases.
The calculation of the boiling point of water is used to
demonstrate the effect of the non-ideal gas data.
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Boiling Point of Water: Ideal Gas Calculation Settings

Products:
•a liquid phase;
•an ideal gas phase

Final Conditions:
T = 0°C and 150°C;
P = 1atm;
and any transition point in the temperature interval
Equilib 9.1
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Boiling Point of Water: Ideal Gas Calculation; Results: Tb(water) = 100.35°C
The asterisk in front of T = 100.35°C
indicates the calculated value …

Compare the final
volume of the phase

… for the equilibrium temperature
between H2O(g) [ideal gas phase] and
H2O(L1) [i.e., the ideal boiling point]
Equilib 9.2
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Boiling Point of Water: Real Gas Calculation Settings

Products:
•a liquid phase;
•an real gas phase

Final Conditions:
T = 0°C and 150°C;
P = 1atm;
and any transition point in the temperature interval
Equilib 9.3

Possible selection of solution
species (the box Show and the
radio button all are checked).
www.factsage.com

Boiling Point of Water, Real Gas Calculation Results Tb = 100°C [ChemSage Output]
The asterisk in front of T = 100°C
indicates the calculated value …

Compare the final
volume of the phase

… for the equilibrium temperature
between H2O(g) [real gas phase]
and H2O(L1) [i.e., the real boiling point]
Equilib 9.4
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Adiabatic combustion, use of the Alpha parameter

The following two slides show how an extensive property target
is calculated using ∆H as the target property and T as the target
variable, i.e. the variable the value of which is adjusted to satisfy
the target condition.
The combustion of CH4 with O2 is used as an example.
Furthermore, the use of the <Alpha> parameter is demonstrated.
Here <Alpha> is used to handle the variable mole fraction of the
two input gases.
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Adiabatic Reaction between CH4 and O2 – Specifying an Extensive Property, ∆H=0
Possible products are:
• an ideal gas phase;
• pure liquids and
• pure solids.

Select «Initial Conditions»
with the checkbox.

For an adiabatic
reaction, set ∆H=0.
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Equilibrium Products and Final T of the Adiabatic Reaction between CH4 and O2

Product T is 3053 K. Clearly a
very high temperature. It can be
used for flame spectroscopic
applications.

No condensed phases

Note:
∆H=0;
∆S is a maximum for
specified input conditions
Equilib 10.2
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Fixing the activity of a component in the equilibrium state

In the following four slides is shown how the Equilib module can
be used in order to perform calculations which do not use an
amount of a substance but rather its chemical potential, here the
partial pressure of a gas species.
As an example FeS is considered in a gas atmosphere with a
given O2 partial pressure.
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Fixing the Activity of a Species O2(g) in the Product Equilibrium FeS and O2
To view a list of the
species selected before
computation, press the
«List Window» button.

Note: 1.8 mol O2

Click mouse right button to custom select species for gas species.

1. To fix the activity of a species as O2(g),
click the mouse right button on the
name of the phase containing the species
you want (in this case, the gas phase).

A right click in the «compound
species» frame will provide
you some information
Equilib 11.1
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Fixing the Activity of a Species
2. Click the mouse right button in the first column of the
line containing O2(g) species, a context menu opens…

3. Select «activity» in the
sub-menu «a Activity»
to open a dialog box

4. Fix the activity (or partial
pressure) of the species;
Press «OK».
Equilib 11.2
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Activity of O2(g) in the product equilibrium FeS and O2: Custom activity details
5. Partial pressure of O2 is
fixed: PO2 = 1 × 10-2 atm
Press «OK» to return to
Menu Window

6. The «Custom solutions» frame
indicates: 1 fixed activity …
For more information, press «Details»

7. Press « Calculate >> »
Equilib 11.3
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Activity of a Species O2(g) in the Product Equilibrium FeS and O2 : Results window
0.03709 mol O2 must be added to the reactants in order
to have the final equilibrium partial pressure for O2

i.e. FeS + 1.83709 O2 as reactants

PO = 0.01 atm
2

Products

Equilib 11.4
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Assembling an ideal liquid and adding activity coefficients

In the following 16 slides is shown how in the Equilib module
two pure liquid components are used to describe a custom
defined liquid solution.
First ideal mixing is assumed, then a comparison with the known
phase diagram is used to derive activity coefficients via the
Reaction module. Finally the activity coefficients are applied in
complex equilibrium calculations using the Equilib module.
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Setting up of an ideal liquid solution of Cu and Cr
1. In order to define the components of an ideal liquid solution,
click the mouse right button on the name of the phase
containing the species you want (in this case, liquid).

Click mouse right button to custom select species for liquid species.
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Setting up of an ideal liquid solution of Cu and Cr
2. Click the mouse right button in the first column (+) of the
line containing Cr(liq) species – an extended menu appears.

Click mouse right button for extended menu on Cr(liq).

3. Click on «Ideal Solution #1» in submenu «Ideal Solution» to select
Cr(liq) as the first component.

4. Repeat steps 2 and 3 to select Cu(liq) as
the second component of Ideal Solution #1.
Equilib 12.2
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Liquid Cu-Cr alloy assuming ideal mixing of Cu and Cr
6. Press «OK» to return to the Menu
Window where the «Custom Solutions»
label box indicates: 1 ideal solution …
For more information, press «Details»

5. Cr(liq) and Cu(liq) are
the components of
«Ideal Solution #1»
7. Set Final Conditions
and press
«Calculate >>»
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Results window – assumption of Cr(liq) - Cu(liq) ideal mixing.
ChemSage format

Ideal solution phase:
liquid#1
Numbers are mole fractions
XCr(liq) = 0.4
XCu(liq) = 0.6

FactSage format
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List window – assumption of Cr(liq) - Cu(liq) ideal mixing
Ideal solution, hence
XCu(liq) = aCu(liq) = 0.6
XCr(liq) = aCr(liq) = 0.4

List Window
• check Show,
Species «selected»;
• select:
Format «mole» and
Order «code».
Option Show
«properties» checked

According to the phase diagram (next page):
XCr(liq) = 0.01837 at 1373.15 K (1100°C).
Hence, the assumption of an ideal solution is not very good in this example.
Equilib 12.5
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Tie-lines in the Cu-Cr phase diagram
T

Cr(liq) Cr(s)

(°C)

(wt %) (wt %)

1100 1.508

100

1200 3.456

100

1300 7.155

100

1860 °C

1300 °C (1573.15 K)
1200 °C (1473.15 K)

T (K)

X Cr(liq)

1100 °C (1373.15 K)

X Cr(s) 1084.87°C

1076.6 °C

1373.15 0.01837

1.0

1473.15 0.04193

1.0
100

1573.15 0.08608

Cr

1.0

(ref. D.J. Chakrabarti and D.E. Laughlin, Bull. Alloy Phase Diagrams, p. 100, 1984)
Equilib 12.6
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Input to program Reaction to calculate activity of Cr liquid in equilibrium with solid Cr

Pure Cr(s)
aCr(solid)= 1
(from phase diagram)

Cr(liq) in solution
aCr(liquid) = X

Isothermal reaction, hence equilibrium when ∆G = 0.

Output of interest:
Activity of the
liquid phase
Equilib 12.7
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Estimation of the Henrian activity coefficient of Cr(liq) in Cu(liq)
For dilute solutions we can express the activity

a

Cr(liq)

as a function of the molar

fraction XCr(liq), by applying Henry’s law:
= γ°Cr(liq) XCr(liq)

a

Cr(liq)

where γ°Cr(liq) is the temperature dependant Henrian activity coefficient.

T –1(10 -4 K-1)

γ°Cr(liq)

Log10[ γ°Cr(liq)]

0.46754

7.2825

25.4513

1.4057

0.04193

0.53979

6.7882

12.8736

1.1097

0.08608

0.61161

6.3567

7.1051

0.85157

T (K)

XCr(liq)

1373.15

0.01837

1473.15
1573.15

a

Cr(liq)

The solution is fairly dilute, hence Henry’s law is fairly applicable..
We find that:

log10

[γ °Cr(liq)](T-1) = 5983.29 T-1 - 2.9522
Equilib 12.8
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Modifying the Custom Solution Selection
1. A custom solution selection of the liquid phase species exists. In
order to modify it, click the mouse right button on liquid phase.

Equilib 12.9
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Specifying the temperature dependant Henrian activity coefficient for Cr in Cu(liq)
2. Click the mouse right button in the first column (+) of the line
containing Cr(liq) species and an extended menu appears.

3. Click on «activity coefficient gamma»
in «a Activity» sub-menu to open the
dialog box for Cr(liq).
4. Enter the values A and B of the activity coefficient γ°Cr(liq) in the expression:
(Note: T is in Kelvin)
log10 [γ°] = A / T (K) + B

From the previous page, we have: log10 [γ°Cr(liq)] (T-1) = 5983.29 T-1 - 2.9522
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View of the Selection Window and use of the Show feature
The symbol «a» indicates that an activity coefficient (γ or log10γ)
has been specified for Cr(liq) in the ideal solution #1.
This view of the table with the activity, mole, gram and molar fraction
and weight percent was obtained by selecting: Show > Equilibrium
values > All Equilibrium values from the menu bar.

Cu(liq): Equilibrium activity. Double-click top row to sort the list. Click mouse right button for more…

Equilib 12.11
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View of the Selection Window Help (detailed information)

Equilib 12.12
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Setting the Final Conditions for the Cr-Cu Calculation
5. Return to Menu Window
The «Custom Solutions» label box indicates:
• 1 activity coefficient
• 1 ideal solution
For more informations, press «Details»

6. Set Final Conditions
and press
«Calculate>>»
Equilib 12.13

www.factsage.com

Results for oxidation of Cu-Cr alloy at 1373.15 K.
Liquid alloy coexists with solid Cr – the composition agrees with the phase diagram.
0 mol i.e. no gas phase. However, these mole
fractions give equilibrium partial pressures.
For example: Pcu = 0.76848 × 10-6 atm.

Flag to a custom solution

XCr(l) = 0.01839 same
value as phase diagram

Pure solid Cr

Equilib 12.14
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More Results for Cu - Cr Alloy – T = 1473.15 K and 1573.15 K
1473.15 K
XCr(l) = 0.041963, same
value as phase diagram.

Pure solid Cr

1573.15 K
XCr(l) = 0.086158, same
value as phase diagram.

Pure solid Cr

Equilib 12.15
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List Window – a Summary of Activities of Cr and Cu in Liquid Alloy
Compare Cr
concentration in liquid
alloy with liquidus in the
binary phase diagram
Cu - Cr (see earlier slide
12.6)
12.6 .

1373.15 K

1473.15 K

1573.15 K

Equilib 12.16
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Standard equilibrium with ideal aqueous solution

In the following four slides is shown how use is made of the ideal
aqueous solution data for elevated temperatures and pressures.
The leaching of an arsenic-bearing copper concentrate is used
as an example.
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Leaching of an arsenic-bearing copper concentrate.
Arsenic-bearing copper concentrate

Leaching agent

• Two ideal solutions:
gas and aqueous;
• and pure solids.

Elevated T and P
Equilib 13.1
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Results Window FACT output for the leaching of an copper concentrate
The ideal gas phase species

The reactants

XH O = 0.80267
2
Ptotal= 5.0 atm
PH2O=XH2O×Ptotal
= 4.01335 atm

Equilib 13.2
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Results Window FACT output for the leaching of an copper concentrate
The aqueous phase species

Note the potential
with respect to the
standard H2(g)
electrode.

Important:
in aqueous solutions the solutes are given
with respect to 55.5 mol(1000 g or 1L) of
water. Hence, the values are molalities.
For example:
mH[+] = 0.49921 hence
pH = -log10 (0.49921) = 0.302

Equilib 13.3
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Results Window FACT output for the leaching of an copper concentrate
The solid phase species

Three pure solids at
equilibrium with the
aqueous and gas solutions.

Equilib 13.4
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Standard equilibrium with dilute solution phase

The following two slides show the use of a dilute metallic liquid
phase from the FACT database, here Fe-liq, in the Equilib module.
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Selection of FACT Non-Ideal Solutions: FACT-FeLQ. The Menu Window Interface.
A click in the «Fe-liq» cell gives (note that all this info appears in the «Custom Select
full title name:
Species» window):
short description of the complete solution phase:
list of possible components for the current system:

Fe-liq steel using M*O associate model of In-Ho Jung, with solutes Ag, Al, B, C, Ca, Ce, Co Cr,
Cu, H, Hf, La, Mn, Mo, Mo, N, Nb, Nd, Ni, O, P, Pb, Pd, S, Si, Sn, Ta, Th, Ti, U, V, W and Zr
Click mouse right button for extended menu on FACT-FeLQ.

“*” denotes custom selection – not all the species have been selected.
Click mouse right button to custom select species for FACT-FeLQ.

Equilib 14.1
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Results Window FACT format output –solubility of C in liquid cast iron
Compositions in the
liquid solution phase
Fe-liq are given in weight
percent (wt. %).
The amount of:
• Fe is 100.00 g =
93.332 % × 107.14 g
• Mn is 1.00 g =
0.93332 % × 107.14 g
• Si is 1.00 g =
0.93332 % × 107.14 g
• C is 5.1440 g =
4.8011 % × 107.14 g

Graphite saturation

Equilib 14.2
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Adding a slag to the Fe-Mn-Si-C system

The following six slides are devoted to a special case in the
FACT database: The use of a slag phase when several options
concerning the composition of the slag ( SlagA, SlagB, Slag? )
are available.
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FACT Non-Ideal Solutions: Listing the available solution datasets.
There are 20 solution datasets
available for this mix of reactants
in the FACT Solution database

To see the list of Solution species:
Check «Show» and select «all»
Then scroll through the list.
Equilib 15.1
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More information about the available slag and liquid iron solution phases.

You must remove either CaCO3 or MgS from your selected components of FACT-SLAG?See the Equilib manual for more information

Possible «solutions»
for the calculation.

You can select only one phase in a list of phases with 5-character names differing only
by their last character. Here, SLAGA, SLAGB and SLAG? are mutually exclusive.
Equilib 15.2
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Selection of the solution phases for the decarburisation of pig iron by oxygen injection

There are 3 subsets of the solution phase FACT-SLAG: FACT-SLAG?;
FACT-SLAGA; FACT-SLAGB. Only one can be selected.
The reason why there are solution subsets is because not all the binary,
ternary systems, etc…, in the complete solution have been optimized yet.
«?» indicates that not all the species have been optimized together and a
selection of this phase is not recommended.
In the present example, we select FACT-SLAGA (the complete oxide
phase) rather than FACT-SLAGB (a limited carbonate phase).

Selection of 2 liquid
solution phases: FACTSLAGA, FACT-FeLQ;
and 2 phases: ideal gas
and pure solids.
Enter the Final
Conditions and
Calculate >>

Equilib 15.3
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FACT Non-Ideal Solutions: warning about the modification of a solution phase.

You can examine or modify a solution phase but …

Equilib 15.4
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Decarburisation of pig-iron by oxygen injection (Results window, FACT format)
Reactants, <A>= 5

Almost 100 % CO(g)

CaO addition promotes
slag formation.

•Less C in liquid steel
because C has mostly gone
into the gas phase.
•Less Si in liquid steel
because of its oxidation into
the slag.
No solid phases

Equilib 15.5
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Decarburisation of pig-iron by oxygen injection (Results window, ChemSage format)

Equilib 15.6
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A standard case with slag-metal input plus additives

The following six slides show how the Equilib module is applied
to a steel metallurgical question involving a liquid Fe-based
solution, a slag phase, a gas phase based on argon and the
addition of CaSi to treat the oxygen content of the Fe-liquid
phase.

Equilib 16.0
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Desulfurizing a steel by CaSi addition. Reactants entry.

Starting composition
of the steel melt

Note the use of the
variable amount
<A> for the slag.

Calcium silicide
addition
Equilib 16.1
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«initial conditions» Default Values and Stream Features

Stream# boxes

«initial conditions»
check box

These are the defaults values for the reactant species when the «initial conditions»
box has been checked.
• Specifying initial conditions is only useful if you want to calculate or constrain changes
in the extensive properties (∆V, ∆H, etc…). You have to select, for each reactant
species, the phase, the temperature, the total pressure and the stream number.
• All reactants in a given stream are grouped together, they have the same
temperature and total pressure. If you change the temperature (or pressure) of any
one member of the stream, then the temperature (or pressure) of all the other
members of the stream will be changed to the same common value.
Equilib 16.2
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Desulfurizing a steel by CaSi addition, selection of solution phases and final conditions

Summary of the
Reactants window
Solution species
selected

Final conditions:
• <A> = 0.015
• T = 1627°C
• P = 1 atm
and Calculate >>

Equilib 16.3
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Desulfurizing a Steel by CaSi Addition. FACT Format Results.

Gas phase,
mainly Ar

Two liquid solutions:
• slag containing sulfur
• liquid steel

No solid phases
(activity<1)
Equilib 16.4
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Desulfurizing a Steel by CaSi Addition. ChemSage Format Results (4 parts)
2

1

Final Conditions

STREAM CONSTITUENTS
or AMOUNT of reactants

Product solution steel
(FELQ or Fe-liq) phase

Product gas
phase, mainly Ar

Product solution slag (SLAGA
or Aslag-liquid) phase

Equilib 16.5

www.factsage.com

Desulfurizing a Steel by CaSi Addition. ChemSage Format Results (4 parts)
3

4

is 1. 00E-04
outside their valid temperature range

Mass fractions of
system components

No pure solid phases

Equilibrium thermodynamic values
Equilib 16.6
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A standard case with aqueous solutions

The following two slides show how Equilib is used for calculations
of equilibria in which a non-ideal aqueous phase is involved.
The aqueous phase is described by the Pitzer model which permits
high concentrations of dissolved aqueous species to be treated.
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Non-Ideal Aqueous Solutions: FACT-PITZ (Pitzer)
Mixing 10 mol of NaCl and 1 mol of water at 25°C and 1 atm
creates brine saturated in NaCl.

Equilib 17.1
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Solubility of NaCl in water

Aqueous phase results with respect to 55.508 mol H2O
(i.e. 1 Kg H2O) hence in molalities.

log (5.4058 × 10-7) = 6.597

Here the solubility of NaCl in water at
25°C is mNaCl = 6.1337 mol/kg H2O

Equilib 17.2
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Heterogeneous equilibria and the phase rule

The following five slides show how the heterogeneous phase
equilibria calculated using Equilib are subject to the Phase Rule.
For a series of calculations with fixed temperature and pressure
and variable composition it is shown how many degrees of
freedom are left for the various equilibrium states calculated.
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Simple Heterogeneous Equilibria and the Phase Rule:
Oxidation of iron sulfide
by a variable amount
(<A>) of oxygen

A multiple entry for the
variable quantity <Alpha>
<Alpha>first = 0.6
<Alpha>last = 0.65
and step = 0.01

6 calculations will be performed for
<A> from 0.60 to 0.65 in increments
of 0.01 (0.60, 0.61, 0.62, … , 0.65).
Equilib 18.1
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FeS Oxidation and Results when <A> = 0.60 mol (FACT Format)
T=1000 K, <A> = 0.60 mol

Products:


ideal gas phase solution:
mainly SO2



1st solid phase: Fe3O4(s2)



2nd solid phase: FeS (s3)

Equilib 18.2
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FeS Oxidation and Results when <A> = 0.61 mol (FACT Format)
Note:
Same phases and gas
partial pressure as for
<A> = 0.60 mol but
different amounts.
This is explained by the

T=1000 K, <A> = 0.61 mol

Phase Rule:
F=C–P+2
where C=3 and P=3,
hence F=2 (T and P).
At 1000 K and 1 atm,
the system is invariant.

Products:


ideal gas phase solution:
mainly SO2



1st solid phase: Fe3O4(s2)



2nd solid phase: FeS (s3)
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FeS Oxidation and Results when <A> = 0.62 mol (FACT Format)
T=1000 K, <A> = 0.62 mol

Products:




ideal gas phase solution:
mainly SO2
a solid phase: Fe3O4(s2)

Note:

All FeS(s3) is oxidized
Now only 2 phases (P = 2)
exist.
From Phase

Rule:

F=3
and gas phase
composition varies in
equilibrium with Fe3O4 (s2),
the system is univariant.
Equilib 18.4
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FeS Oxidation and Results when <A> = 0.65 mol (FACT Format)
T=1000 K, <A> = 0.65 mol

Products:


ideal gas phase solution:
mainly a mixture of SO2
and SO3

Note:
Oxidation is complete.
Fe2O3(S1) is the stable
product.

Equilib 18.5
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